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Version 5.5 of Analyzer features numerous innovative and useful enhancements. Here are the 
Top 10: 

• Procedure scheduling – Server-based procedures may now be scheduled from the Overview 
with a right-click. There is no need for a separate product or user interface. Scheduling 
options range from Now to Monthly. Also, depending on the test, results can be 3-10 times 
faster than Fuzzydup. We have test files you can use, if you don’t have appropriate data.

• Duplicates Same-Same-Near and Same-Same-Similar – You can now look for fuzzy 
duplicates within a file using the Duplicates command. The ability to specify “Same” keys 
makes the command dramatically more powerful than that other company’s Fuzzydup 
command. This allows you to, for example, test for same vendor, same date, similar invoice 
number, as well as process millions of records in seconds. 

• Procedures are now independent of your individual preference settings – Setting changes 
made by a procedure are automatically reversed on completion. Also, the new Set Default 
command ensures “factory” settings are in place for your procedure, which you can then 
modify as required.

• SIMILAR( ) function – This new function complements the fuzzy NEAR( ) function. 
SIMILAR is also fuzzy, but is specifically designed to ignore differences due to visually 
similar characters (such as I vs. 1 or 0 vs. O). It also allows testing for transpositions of digits 
in numbers and dates.

• LISTFIND( ) function – This function allows you to easily scan for an unlimited list of words 
in a file or fields. This is particularly powerful for purchase card analyses.

• Auto-loading Workspaces – You may now refer to Workspace fields directly in any 
expression (including Views and computed fields) using the familiar x.y format, without the 
need to first activate the Workspace. In this case, x is the name of the workspace and y is the 
field name. When using this syntax, the Workspace is automatically loaded.

• Copy and Paste fields – You may now move field definitions between tables with a 
simple copy and paste in Edit Table Layout. This eliminates the need for awkward uses of 
Workspaces and applies to all field types, including computed fields.

• Extract View – This allows you to easily extract the data showing in the current view, in the 
same manner as previously available for Export.

• Multi-Parameter Functions – A number of functions (e.g., Maximum) have been extended 
to allow any number of parameters. These functions can also take a variable array as a 
parameter, and will process the entire set of values as if they were individual parameters.

• Sort and Index – The algorithm has been revised, improving speeds significantly.

ArbutusSoftware.com

Based on 25 years of innovation excellence, 
Arbutus delivers the very best in purpose-built 
audit analytics technology to meet the exacting 
demands of today’s business environment. 
Auditors, business analysts, and fraud 
investigators rely on Arbutus audit software to 
enhance their testing, analysis, and compliance 
capabilities.

What’s New in Analyzer Version 5.5 
Documentation – December 2013    



Windows Server 
Added a Scheduler for Scheduling Procedures stored in Shared Folders on an Arbutus 
Windows Server directly from Analyzer. Scheduling is only available for Enterprise (server) 
implementations. 

• Procedures can be scheduled for a specified date and time, or for a specified interval 
(daily, weekly, or monthly, at a specified time).

• In addition to the date and time run, you can specify a result (such as number of 
exceptions), that will show in the Overview, next to the run.

• Output tables created can be stored privately (to the folder specified in your output 
prefix), shared (to a common server folder) or to any other accessible network folder. Private 
scheduled jobs are most useful for individual analyses, whereas Shared output is most 
useful for ETL.

• Scheduled jobs can utilize the Notify command, so you can signal completion, or perhaps 
exceptional situations, with an email.

• Scheduled jobs can use all the standard user interface capabilities of Analyzer, such as the 
dialog command. Whenever a scheduled procedure contains interactive elements, then that 
portion of the procedure is run BEFORE the procedure is scheduled, and the values entered 
are passed to the job. The new SCHEDULE START and SCHEDULE END commands must 
bracket any interactive portion of a scheduled job.

• Added a Server Explorer capability, allowing users to work with files on their Arbutus 
Windows Server without having to use the Data Definition Wizard. Capabilities include 
browsing, renaming, and deleting files, as well as creating new folders.

• Windows Server performance improved; results will vary based on the command issued.

• Added support for concurrent user licensing on Arbutus Servers.
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• Result logs (above) are shown in 
the Overview and are color-flagged to 
indicate whether a particular run was 
successful (green) or failed (red). You 
can also programmatically specify a 
warning condition (yellow) as an alert.



Analyzer – Procedures 
• The current application settings (Preferences) are now automatically saved prior to 
running a procedure. When the procedure is completed, these application settings are 
restored to the saved values. This new functionality ensures that running a procedure 
only temporarily changes the user’s preferences and that a procedure can no longer 
permanently affect the application settings from within a procedure.

• Added a SET DEFAULT command which sets all preferences to their default values. 
Typically, the SET DEFAULT command is followed by desired SET commands to 
establish the necessary user settings required for the procedure to run correctly and 
consistently (like Set Safety off). The SET DEFAULT command is equivalent to the SET 
DEFAULT button in Tools > Options, but of course only applies while the procedure is 
running.

• Enhanced the SET SAFETY OFF command to also control the overwriting of fields/
variables without asking. As a result, if your procedure defines fields (and safety is 
OFF), there is no longer the need to delete the field in the procedure prior to defining it 
for subsequent running of the procedure.

Analyzer – Commands

• Enhanced the DISPLAY command to support new options:

• The VERSION parameter will now create a numeric variable.  
This could be useful when conditionalizing commands issued  
within procedures that are dependent on the version of Analyzer  
being used.

• When workspace fields have been activated, issuing a DISPLAY will now list 
workspace fields using an x.y naming convention (similar to how related fields are 
referenced).
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• Added Duplicates Same-Same-Near functionality (at right), which 
supports the easy execution of fuzzy duplicate tests. Exact field 
values can be combined with a near field value (e.g., test for same 
date, same amount, near vendor name). This command uses the 
NEAR( ) function (Damerau-Levenshtein distance for strings; a 
numeric value for numerics; and a number of days for dates).

• Added Duplicates Same-Same-Similar functionality. This is close 
to Same-Same-Near, but is specifically designed for fuzzy duplicate 
testing on accounting reference fields, such as invoice number or 
product number. This type of data is vulnerable to characteristic 
data entry errors or inconsistencies which can lead to duplicate 
payments or other accounting errors (e.g., same amount, same 
vendor, similar invoice number, like I1928 and 11928). This 
command uses the SIMILAR( ) function.

• Enhanced the speed of the SORT and INDEX commands 
(including presort/secsort).

• Added support for use of the AS field modifier for fields in an 
IMPORT command. This allows you to change the name of a field 
from the source.

• Added enhancement to EXTRACT so you can now extract the 
current view.



Analyzer – Functions 
• Enhanced MATCH( ) to support variable arrays as parameters for the matching list. If the 
variable array ‘items’ has the values “10”, “20”, “30”, “40” and “50”, then MATCH(dept, 
items) is the same as: MATCH(dept, “10”, “20”, “30”, “40”, “50”).

• For any functions that support multiple parameters and variable arrays, you can also mix 
combinations of parameters and variable arrays, so if items and items2 are arrays, then 
MATCH(dept, items, “88”,”99”, items2) would be valid. Of course, wherever a variable 
array is valid it can be as large as required.

• Added AVERAGE( ), to return the average value for a set of specified numbers, or a set of 
numbers stored within a specified variable array. Any number of parameters and/or variable 
arrays may be supplied: AVERAGE(4.7, 18.42, 19.63, 6, 0, 1.123, 10.5)=8.625

• Added LISTFIND( ), to find any of a list of words (case insensitive) specified in one 
or more text files or from a single specified variable array. This is particularly useful for 
purchase card analyses, where the data is being scanned for inappropriate or suspicious 
terms. The LISTFIND( ) function finds matches in upper, lower, and mixed cases and also 
searches for either ASCII or EBCDIC characters based on the field definitions. Use Listfind 
in a filter like LISTFIND(“exceptions.txt”, description).

• Added SIMILAR( ). This is another “fuzzy” function that complements NEAR( ).  
SIMILAR( ) returns true or false based on a fuzzy comparison of the parameters. It 
transforms its parameters before comparison, to eliminate the most common data entry 
errors, and then compares the results using the Damerau-Levenshtein distance. This 
function differs from NEAR( ) because it compares transformed values.

• For strings, it upper-cases, removes all non-alphanumerics (e.g., blanks, commas, 
quotes, dashes, periods, etc.), replaces foreign characters with their English equivalents, 
and eliminates certain letter combinations that are easily confused (such as I/1 or O/0).

• For numeric and date data it converts the values to strings for comparison. This will 
easily identify data transpositions that might otherwise be missed because the resulting 
incorrect value is quite different from the correct value.

• Unlike NEAR( ), it is reasonable to specify a distance of zero. This implies two 
values that may or may not be identical in their raw form, but are identical after the 
transformation: SIMILAR(“I - 12345”, “112345”, 0) would be true, for example.

• Added TOTAL( ) to return the total value for a set of specified numbers or a set of 
numbers stored within a specified variable array: TOTAL(4.7, 18.42, 19.63, 6, 0, 1.123, 
10.5)=60.373

• Enhanced DIFFERENCE( ) to include an optional third parameter to turn off case 
sensitivity for the difference comparison. By default, the DIFFERENCE( ) function is case-
sensitive: DIFFERENCE(“Smith”, SMYTHE”, F)=2

• Enhanced the MAXIMUM( ) and MINIMUM( ) functions to support date values, any 
number of function parameters and to support variable arrays. For example: 
MINIMUM(4.7, 18.42, 19.63, 6, 0, 1.123, 10.5)=0.000

• Enhanced VALUE( ) to support an optional decimal character parameter, for when it 
differs from the default preference setting. This is useful for processing numeric data that is 
formatted differently than your national defaults. For example:  
VALUE(“5,67”, 3, “,”)=5.670

• Added ISDEFINED function.
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Analyzer – Functions  (cont’d)
• Enhanced NORMALIZE( ) and SORTNORMALIZE( ) to support specification of multiple 
substitution files. This allows you to keep separate substitution files by area. For addresses, 
you might have separate street descriptions (Ave, Avenue), state names (Washington, WA), 
directions (N, SW), country names (Canada, CAN, CDN) or even numeric designations 
(Twelfth, 12th). Any number may be specified and combined as required. You might even 
store the list in a variable, so it is both easy to refer to while still being easy to maintain. 
When multiple substitution files are desired, just separate the file names with commas in 
the parameter. For example, NORMALIZE(address, “streets.txt,states.txt,countries.txt”) will 
automatically combine the substitutions specified in the three separate files.

Analyzer – Edit Table Layout
Added right-click options to the Edit Table Layout window to easily copy and paste 
field definitions between table layouts. This is particularly useful for copying common 
computed fields between table layouts rather than using a Workspace.

Analyzer – View
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• You may now Quick Filter for 
similar values. See SIMILAR( ) for a 
description of the function.

• You may now set Quick Filters based 
on defined Triggers for a selected 
column. This option is only available 
when a column is highlighted, versus a 
“cell”, if column triggers exist for the 
highlighted column.

• Changed Smart Search so that when 
no columns are selected it searches the 
actual data in the View for matches, 
rather than the primary record. A 
new SMARTSEARCH() function has 
replaced the old FIND() that used to be 
used when performing a Smart Search. 
This will search any data shown in 
the View, any data shown in the View, 
including computed fields, expressions, 
and related fields.

Quick Filter example: this 
choice uses the SIMILAR( ) 
function to construct a 
Quick Filter using a default 
Damerau-Levenshtein 
difference of 1 (which can be 
edited).

• SmartSearch now matches if multiple items appear in any of the fields in the View (rather 
than all in one field). 

Analyzer – Overview
• The Overview now mirrors Windows Explorer by placing folders above the other project 
items, in alphabetical order.

• Opened objects can now be moved within the Overview. They are automatically closed 
before moving.



Analyzer – Shared Folders 

 
Note: Refreshable table layouts and table layouts containing relations are only maintained 
when a table layout is moved within the same root folder (e.g., from the root to a sub-
folder within the root).

• Removed the read-only nature of Shared Folders so project items (e.g., procedures) can 
be edited within the shared folder without the need to drag the project item to the desktop’s 
project folder. This, of course, is controlled by the Windows rights you have to the shared 
folder contents, so if the folder is “read-only” for a given user, then they will not be able to 
edit the contents.

• Additionally, shared objects can now be dragged directly between Shared Folders 
(including sub-folders within them). 

• Removed the “Manage Shared Objects” preference from the Tools > Options > Interface, 
as this is now controlled by the Windows security settings.

Analyzer - General 
• Auto-loading Workspaces have been added. Workspace fields can now be specified using 
the familiar x.y style, meaning Workspace-name.field-name. This style can be used in any 
expression, including the View and Computed fields. When you specify a workspace field in 
this way, the workspace is automatically Activated if it is not active already.

• Improved the field display command (Display, Edit Table Layout, Field Picker, etc.) to 
distinctly identify Workspace fields. These are now shown using the x.y style, for easy 
identification.

Tip: Use of the x.y style of referencing workspaces alleviates the need to issue an 
ACTIVATE WORKSPACE command.

• Changed the naming convention for the underlying file name of View/Report and Index 
files, to make it easier to see the relationship between Views/Indexes and their parent Table:  
demo .avw (default view for demo.fmt) 
demo altdemo.avw (alternate view for demo.fmt)

Note: This does not change the way Views/Reports and Indexes are displayed in the 
Overview; only the way they are displayed in Windows Explorer.

• When creating a New Project from the File menu, a new project folder is automatically 
created at the same level as the current folder. A named project file is automatically placed 
into this new folder. The new project file uses the same name as the new project folder. This 
ensures that a new project starts “empty”.

• Enhanced the table properties to include Relations information, in the Notes area, if 
parent tables with relations are moved to a shared folder.

• File DSNs are now supported via the Wizard and Import command.
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• Added a Share top level menu (at right) to create and 
manage shared folders (Personal, Team, and Enterprise).

• Added right-click support for Shared Folders to display 
properties within the Overview.

• Added ability to drag local table layouts into Shared Folders 
in order to transfer data and results between users. Users are 
prompted to optionally move local data into Shared Folder with 
local table layouts.
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